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CALIBRATION PROCEDURE

NI PXI-4220
This document contains the information and instructions needed to 

calibrate the NI PXI-4220.

You should calibrate the NI PXI-4220 at a regular interval as defined by the 

measurement accuracy requirements of your application. NI recommends 

that you perform a complete calibration at least once every year. Based on 

your measurement accuracy needs, you can shorten this interval to 90 days 

or six months.

NI recommends verifying the operation of NI PXI-4220 prior to high 

accuracy applications. This document contains the NI PXI-4220 accuracy 

verification and adjustment procedure.

Conventions

The following conventions appear in this document:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names and hardware labels.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Monospace text denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 
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programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen. This font also emphasizes lines of code 

that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 

that you must supply.

Software

Calibration requires the latest version of NI-DAQmx, which includes 

high-level function calls to simplify the task of writing software to calibrate 

devices. NI-DAQmx supports many programming languages, including 

LabVIEW, LabWindows™/CVI™, Microsoft Visual C++, Microsoft Visual 

Basic, and Borland C++.

Documentation

The following documents are your primary references for writing your 

calibration utility:

• The NI-DAQmx C Reference Help includes information about the 

functions in NI-DAQmx.

• The DAQ Getting Started Guide provides instructions for installing 

and configuring NI-DAQ devices.

• The SCXI Quick Start Guide includes information for installing and 

configuring the SCXI-1600.

• The NI-DAQmx Help includes information about creating applications 

that use NI-DAQmx.

You can add these help files when you install NI-DAQmx. After adding 

these help files, you can access them by selecting Start»Programs» 

National Instruments NI-DAQ»NI-DAQmx Help. The documents 

provide instructions on installing and configuring DAQ devices. The 

documents also include detailed information on creating applications that 

use NI-DAQmx. These are your primary references for writing your 

calibration utility. For more information on the NI PXI-4220, refer to the 

NI PXI-4220 User Manual.
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Test Equipment

Calibration calls for a high-precision voltage source with at least 50 ppm 

accuracy, a multiranging 5 1/2 digit digital multimeter (DMM) with 

15 ppm accuracy. With the preceding conditions met, you can achieve 

proper calibration.

NI recommends the following instruments for calibrating the NI PXI-4220:

• Calibrator—Fluke 5700A.

• DMM—NI 4070 or Agilent 34401A.

If these instruments are not available, use the accuracy requirements listed 

above to select a substitute calibration standard.

Note A suitable 9-pin D-SUB adapter is recommended for connecting external signals to 

the analog ports. The input connections on both channels are discussed in this document 

and are shown in Figure 2.

Test Conditions
Follow these guidelines to optimize the connections and the environment 

during calibration. Following these guidelines helps ensure accurate 

calibration result:

• Keep connections to the PXI module short. Long cables and wires act 

as antennae, picking up extra noise and thermal offsets that can affect 

measurements.

• Use shielded copper wire for all cable connections to the NI PXI-4220. 

Use twisted-pair wire to reduce noise.

• Maintain the temperature between 18 and 28 °C.

• Keep relative humidity below 80%.

• Allow a warm-up time of at least 15 minutes for the NI PXI-4220 to 

ensure that the measurement circuitry is at a stable operating 

temperature.
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PXI-4220 Pinouts

Figure 1 shows the front label of the NI PXI-4220.

Figure 1.  Front Label

2 Channel Bridge Input
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CAL

NI PXI-4220
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Figure 2 shows the NI PXI-4220 front connectors.

Figure 2.  Front Connections

Calibration Process

Note  The calibration procedure is for an NI PXI-4220 installed in PXI chassis using an 

external calibrator and DMM. The procedure is similar for other system configurations.

The steps used in the calibration process are as follows:

1. Setting up the NI PXI-4220 for testing.

2. Verifying the existing operation of the NI PXI-4220 to determine 

whether it is operating within its specifications.

3. Adjusting the offset and gain errors using a known external voltage 

source.

4. Verifying that the NI PXI-4220 is operating within its specifications 

after adjustments.
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Setting up the NI PXI-4220 for Verification
Complete the following steps, while referring to Figures 3 and 4, to set up 

the NI PXI-4220 for testing.

1. Make sure all components involved in the calibration procedure are 

powered-off.

2. Connect an SMB cable to the PFI 0/CAL port.

3. Connect pins S+ and S– of the channel you want to verify to the 

calibrator output. See Figure 2 for pin layout. If the calibration signal 

is floating, connect S– to chassis ground.

4. Connect pins P+ and P– of the channel you want to verify to a DMM 

to verify the excitation voltage.

5. Power on the PXI Chassis and then the external computer if using one.

6. Make sure that all the appropriate driver and application software is 

installed.

7. Confirm that the hardware is properly configured with Measurement & 

Automation Explorer (MAX). For more information on configuring 

the system, refer to the documentation for the NI PXI-4220 module.
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Figure 3.  Typical NI PXI-4220 Setup for MIO Baseboard Calibration
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Figure 4.  Typical NI PXI-4220 Setup for Signal Conditioning Component 

Verification and Calibration

8. In the functions used for demonstrating the following calibration 

process, use the device ID dev1. To verify that the device is properly 

named, complete the following steps:

a. Open MAX.

b. Expand Devices and Interfaces»NI-DAQmx Devices in the 

Configuration window.16

c. Verify that the NI PXI-4220 is named dev1. If it is not, right-click 

the device to rename it. Refer to the MAX documentation for 

instructions.
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Verifying Gain and Offset Errors
The verification procedure determines how well the NI PXI-4220 module 

is meeting its specifications. You can use this information to select the 

appropriate calibration interval for your application.

The NI PXI-4220 stores gain calibration constants for each gain setting per 

analog input channel in addition to an offset constant for each channel. A 

complete verification of the inputs involves measuring the accuracy at all 

possible gain settings on both channels of the NI PXI-4220.

You can find all VIs in LabVIEW using the search tool in the palette.

Complete the following steps to verify gain and offset errors of the 

NI PXI-4220 analog inputs.

1. Read the Test Conditions section.

2. Refer to the specifications in Table 19 for test-point limits.

3. Ensure that no external signals are connected to the NI PXI-4220.

4. Run the Self-Calibrate (DAQmx Self Calibrate VI) function 

before doing the first verification. This function measures the onboard 

reference voltage of the NI PXI-4220 and adjusts the PXI-4220 

baseboard calibration constants to account for any errors caused by 

short-term fluctuations in the operating environment.

5. Connect your calibrator to the appropriate analog input, starting with 

channel 0 at pins S+ and S– inputs. See Figure 2 for pin connections. 

If the source is not ground referenced, reference it by connecting the 

S– to the PXI chassis.

6. Set the calibrator voltage to the desired test point indicated in Table 19.

Table 1.  Self Calibration of the NI PXI-4220

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxSelfCal with the following parameters:

Device_Name: dev1
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7. Create a task using DAQmxCreateTask.

8. Add a channel to the task using DAQmxCreateAIVoltageChan 

(DAQmx Create Virtual Channel VI) and configure the channel.

Table 2.  DAQmx Create Task

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxCreateTask with the following 

parameters:

taskName: "AIVerificationTask"

taskHandle: &taskHandle

LabVIEW does not require this step.

Table 3.  Add a Channel to the Task

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxCreateAIVoltageChan 

with the following parameters:

taskHandle: taskHandle

physicalChannel: "dev1/ai0"

nameToAssignToChannel: 

"myVoltageChannel"

terminalConfig: 

DAQmx_Val_Cfg_Default

minVal: –10.0

maxVal: 10.0

units: DAQmx_Val_Volts

customScaleName: ""
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9. Configure the DAQmx Channel Properties by setting the Gain control.

Note You must acquire three test points per gain setting, as listed in Table 19, to properly 

verify the NI PXI-4220 at any particular gain setting.

10. Configure timing for the voltage acquisition using 

DAQmxCfgSampClkTiming (DAQmx Timing VI). Set the samples 

per channel to 1000 at a sample rate of 1000.

Table 4.  Gain Control and Lowpass Filtering

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxSetAIGain with 

the following parameters:

taskHandle: taskHandle

Channel: ""

Data: (float64 gain 

value for particular 

test-point)

Table 5.  Configure Timing for the Voltage Acquisition

NI-DAQ Function Call LabVIEW Block Diagram

Call 

DAQmxCfgSampClkTiming 

with the following 

parameters:

taskHandle: taskHandle

source: ""

rate: 1000.0

activeEdge: 

DAQmx_Val_Rising

sampleMode: 

DAQmx_Val_FiniteSamps

sampsPerChan: 1000
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11. Start the acquisition using DAQmxStartTask (DAQmx Start 

Task VI).

12. Acquire 1000 points of voltage data using DAQmxReadAnalogF64 

(DAQmx Read VI).

13. Average the voltage values that you acquired.

14. Compare the resulting average to the upper and lower limits listed in 

Table 19. If the result is between these values, the module passes 

the test.

Table 6.  Start the Acquisition

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxStartTask with 

the following parameter:

taskHandle: taskHandle

Table 7.  DAQmx Read Analog

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxReadAnalogF64 with the 

following parameters:

taskHandle: taskHandle

numSampsPerChan: –1

timeout: 10.0

fillMode: DAQmx_Val_GroupByChannel

readArray: data

arraySizeInSamples: 1000

sampsPerChanRead: &read

reserved: NULL
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15. Clear the acquisition using DAQmxClearTask (DAQmx Clear 

Task VI).

16. Repeat steps 6 through 15 for all test points in Table 19.

17. Repeat steps 5 through 16 for the remaining channel.

18. Disconnect the calibrator from the NI PXI-4220.

You have finished verifying the analog input accuracy of the module.

Verifying Voltage Excitation
This section describes how to verify the voltage excitation of the 

NI PXI-4220. If the measured values of the excitation fall outside the limits 

given in Table 20, the module is not operating within specifications. Return 

it to NI for repair. For more information about how to contact NI for repair, 

refer to the Technical Support Information document.

Complete the following steps to verify the voltage excitation of the two 

NI PXI-4220 channels.

1. Read the Test Conditions section.

2. Review Setting up the NI PXI-4220 for Verification for hardware 

configuration.

3. Connect the DMM to the appropriate excitation output terminals 

P+ and P– of the channel you want to verify. Refer to Setting up the 

NI PXI-4220 for Verification to determine pin locations.

4. Create a task using DAQmxCreateTask.

Table 8.  Clear the Acquisition

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxClearTask with the following 

parameter:

taskHandle: taskHandle

Table 9.  DAQmx Create Task

NIDAQ Function Call LabVIEW Block Diagram

Call DAQmxCreateTask with the 

following parameters:

taskName: "AIVerificationTask"

taskHandle: &taskHandle

LabVIEW does not require this step.
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5. Add a channel to the task using 

DAQmxCreateAIVoltageChanWithExcit (DAQmx Create 

Virtual Channel VI) and configure the channel. In LabVIEW you 

must change the polymorphic VI Analog Input»More»Custom 

Voltage with Excitation. Set the excitation voltage using the 

parameters in Table 10.

6. Stop and commit the task using DAQmxTaskControl (DAQmx 

Control Task).

Table 10.  Create Voltage Channel

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxCreateAIVoltageChanWithExcit with 

the following parameters:

taskHandle: taskHandle

physicalChannel: "dev1/ai0"

nameToAssignToChannel: "myVoltageChannel"

terminalConfig: DAQmx_Val_Cfg_Default

minVal: –10.0

maxVal: 10.0

units: DAQmx_Val_Volts

bridgeConfiguration: DAQmx_Val_NoBridge

voltageExcitationSources: DAQmx_Val_Internal 

voltageExcitationValue: (voltage excitation values are 

listed in Table 20, float 64 value)

useExcitationforScaling?: 0

customScaleName: ""

Table 11.  Task Control

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxTaskControl with the following parameters:

taskHandle: &taskHandle

action: DAQmx_Val_Task_Commit



© National Instruments Corporation 15 PXI-4220 External Calibration Procedure

7. Repeat steps 4 through 6 for all excitation values in Table 20. Verify 

that the measured value from the DMM is within the limits specified. 

If so, the NI PXI-4220 excitation voltage is sufficiently accurate.

You have finished verifying excitation voltage levels on the NI PXI-4220.

Adjusting Calibration Constants
The following sections explain how to adjust the calibration constants on 

the NI PXI-4220. You must first calibrate then baseboard and then perform 

both a gain and offset calibration. Do the offset calibration once per analog 

channel and the gain calibration for each gain setting for each analog 

channel. You should complete the Verifying Gain and Offset Errors section 

prior to completing this section to determine the pre calibration values and 

whether you need to make adjustments.

Baseboard Calibration
Perform the baseboard calibration prior to gain and offset calibration. The 

baseboard houses the Analog to Digital Converter (ADC). If it is not 

properly calibrated, an external voltage supply will not be converted 

accurately for the calculations of the calibration constants.

You can find all VIs in LabVIEW using the search tool in the palette.

Complete the following steps to calibrate the baseboard of the 

NI PXI-4220.

1. Review Setting up the NI PXI-4220 for Verification and Test 

Conditions sections.

2. Connect the calibrator to the PFI 0/CAL port using an SMB cable.

3. Start an external calibration session using DAQmxInitExtCal 

(Initialize External Calibration VI). The default password is NI.

Table 12.  Start External Calibration Session (Baseboard)

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxInitExtCal with the following 

parameters:

deviceName: "Dev1"

password: "NI"

calHandle: &calHandle
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4. Adjust the calibrator to a voltage between 6.0 and 9.99 V. The value 

you source must be consistent with the value you choose in your 

software. Use the DAQmxSCBaseboardCalAdjust (DAQmx Adjust 

SC Baseboard Calibration VI).

Note If the reference voltage does not match the declared reference voltage in your 

software, error -200546 occurs and the baseboard remains uncalibrated.

5. Close the external calibration session and commit the calibration data 

using DAQmxCloseExtCal (DAQmx Close External 

Calibration VI).

6. Verify that no errors occurred.

You have finished calibrating the baseboard of the NI PXI-4220.

Gain and Offset Calibration Constants
Perform gain calibrations for each gain per analog channel. NI advises 

calibrations references of 95, 0, and –95% of the full voltage input swing. 

For example, the input swing for a gain of 1 is 10 to –10 V. Therefore, the 

reference points are 9.5, 0, and –9.5 V.

Table 13.  SC Baseboard Calibration Adjustment

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxSCBaseboardCalAdjust with the 

following parameters:

calHandle: calHandle

referenceVoltage: (must be consistent with the 

external reference voltage applied) float64

Table 14.  Close External Calibration Session

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxCloseExtCal with the following 

parameters:

calHandle: calHandle

action: DAQmx_Val_Action_Commit
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Complete the following steps to calibrate the gain constants of the 

NI PXI-4220.

1. Complete the Baseboard Calibration section.

2. Review the Setting up the NI PXI-4220 for Verification and Test 

Conditions sections for instructions on connecting to the analog input 

channel of interest.

3. Start an external calibration session using DAQmxInitExtCal 

(Initialize External Calibration VI).

4. Set the calibrator to the desired voltage for the current gain setting. 

Refer to Table 19 for appropriate voltage set points.

5. Run DAQmxAdjust4220Cal (DAQmx Adjust 4220 Calibration 

VI), with the appropriate voltage set point and gain setting.

Table 15.  Start External Calibration Session (Gain)

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxInitExtCal with the following 

parameters:

deviceName: "Dev1"

password: "NI"

calHandle: &calHandle

Table 16.  Calibration of the Gain Constant at One Gain Setting

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxAdjust4220Cal 

with the following 

parameters:

calHandle: calHandle

channelNames: 

"dev1/ai0"

gain: (reference 

Table 19 for valid 

gain settings) float64.

inputVal: (input 95%, 

0%, and -95% of the 

full range for each 

gain) float64.
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Note You must give the calibrator appropriate time to settle after updating the voltage 

before executing the DAQmxAdjust4220Cal function. This is not implemented in the 

above concept program. To properly calibrate each gain setting, include a wait in software 

after you update the external voltage to account for any settling time requirements for the 

calibrator.

6. Repeat steps 4 and 5 for the three voltage set points at the current gain 

setting from Table 19.

7. Close the external calibration session using DAQmxCloseExtCal 

(DAQmx Close External Calibration VI) to apply the adjustment 

from the current gain setting.

8. Repeat steps 3 through 7 for all gain settings on both channels in 

Table 19.

You have finished adjusting the gain constants on the NI PXI-4220.

Verifying Adjusted Values
After completing the adjustments to the NI PXI-4220, it is important that 

you verify the analog input operation by repeating the steps listed in the 

Verifying Gain and Offset Errors section. Re-verifying after making the 

adjustments ensures that the NI PXI-4220 is operating within its 

specifications.

Specifications

This section lists the specifications for the NI PXI-4220. These 

specifications are typical at 25 °C unless otherwise noted. All 

specifications are with the default filter setting of 10 kHz unless otherwise 

noted. See NI PXI-4220 User Manual for further specification information.

Table 17.  Close External Calibration Session

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxCloseExtCal with the following 

parameters:

calHandle: calHandle

action: DAQmx_Val_Action_Commit
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Analog Input
Number of input channels ...................... 2

Voltage gain settings.............................. Range from 1 to 1000

Accuracy Information

Table 18.  NI PXI-4220 Accuracy Information  

Nominal 

Range Gain

Absolute Accuracy 15 to 35 °C

Absolute 

Accuracy 

at Full 

Scale

% of 

reading 

max,

1 Year

Maximum 

Offset 

(µV)

Noise + Quantization 

(µV) Temperature Drift

Single Pt.

100 pt. 

Average

Gain 

Drift 

(µ/°C)

Offset 

Drift 

(µ/°C)

±10.0 V 1 0.1 3000 5000 500 0.0300 25.00 ±13.5 mV

±5.0 V 2 0.1 1500 2500 250 0.0300 25.00 ±6.8 mV

±1.8 V 4.2 0.1 500 1000 100 0.0300 25.00 ±2.4 mV

±1.0 V 10 0.1 300 500 50 0.0300 25.00 ±1.4 mV

±500.0 mV 20 0.1 150 250 25 0.0300 5.00 ±675 µV

±180.0 mV 42 0.1 75 100 10 0.0300 5.00 ±265 µV

±100.0 mV 100 0.1 50 50 5.0 0.0300 5.00 ±155 µV

±50.0 mV 200 0.1 50 25 2.5 0.0300 5.00 ±103 µV

±18.0 mV 420 0.1 50 10 1.0 0.0300 5.00 ±69 µV

±10.0 mV 1000 0.1 50 10 1.0 0.0300 5.00 ±61 µV

Absolute accuracy is (Voltage Reading) × (% of Reading) + (Offset Error) + (System Noise). 

To include the effects of Temperature Drift outside the range of 15 to 35 °C, add the term ∆T × [(Gain Drift) × (Voltage 

Reading) + (Offset Drift)], where ∆T is the absolute temperature difference between the module, and 15 or 35 °C.
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Gain and Offset
Table 19 contains the specifications for use when verifying and calibrating 

the gain and offset of the NI PXI-4220. If the module was calibrated within 

the last year, the test point value should fall between the Lower Limit (V) 

and Upper Limit (V) values.

Table 19.  NI PXI-4220 Gain and Offset Calibration Table 

Gain Test Point (V) Lower Limit (V) Upper Limit (V)

1 9.5 9.487000 9.513000

1 0 –0.003500 0.003500

1 –9.5 –9.513000 –9.487000

1.15 8.3 8.288200 8.311800

1.15 0 –0.003500 0.003500

1.15 –8.3 –8.311800 –8.288200

1.3 7.3 7.289200 7.310800

1.3 0 –0.003500 0.003500

1.3 –7.3 –7.310800 –7.289200

1.5 6.3 6.290200 6.309800

1.5 0 –0.003500 0.003500

1.5 –6.3 –6.309800 –6.290200

1.8 5.3 5.291200 5.308800

1.8 0 –0.003500 0.003500

1.8 –5.3 –5.308800 –5.291200

2 4.8 4.793450 4.806550

2 0 –0.001750 0.001750

2 –4.8 –4.806550 –4.793450

2.2 4.3 4.293950 4.306050

2.2 0 –0.001750 0.001750

2.2 –4.3 –4.306050 –4.293950

2.4 4 3.994250 4.005750

2.4 0 –0.001750 0.001750
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2.4 –4 –4.005750 –3.994250

2.7 3.5 3.494750 3.505250

2.7 0 –0.001750 0.001750

2.7 –3.5 –3.505250 –3.494750

3.1 3.1 3.095150 3.104850

3.1 0 –0.001750 0.001750

3.1 –3.1 –3.104850 –3.095150

3.6 2.6 2.595650 2.604350

3.6 0 –0.001750 0.001750

3.6 –2.6 –2.604350 –2.595650

4.2 2.3 2.297100 2.302900

4.2 0 –0.000600 0.000600

4.2 –2.3 –2.302900 –2.297100

5.6 1.7 1.697700 1.702300

5.6 0 –0.000600 0.000600

5.6 –1.7 –1.702300 –1.697700

6.5 1.5 1.497900 1.502100

6.5 0 –0.000600 0.000600

6.5 –1.5 –1.502100 –1.497900

7.5 1.3 1.298100 1.301900

7.5 0 –0.000600 0.000600

7.5 –1.3 –1.301900 –1.298100

8.7 1.1 1.098300 1.101700

8.7 0 –0.000600 0.000600

8.7 –1.1 –1.101700 –1.098300

10 0.95 0.948700 0.951300

10 0 –0.000350 0.000350

Table 19.  NI PXI-4220 Gain and Offset Calibration Table (Continued)

Gain Test Point (V) Lower Limit (V) Upper Limit (V)
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10 –0.95 –0.951300 –0.948700

11.5 0.83 0.828820 0.831180

11.5 0 –0.000350 0.000350

11.5 –0.83 –0.831180 –0.828820

13 0.73 0.728920 0.731080

13 0 –0.000350 0.000350

13 –0.73 –0.731080 –0.728920

15 0.63 0.629020 0.630980

15 0 –0.000350 0.000350

15 –0.63 –0.630980 –0.629020

18 0.53 0.529120 0.530880

18 0 –0.000350 0.000350

18 –0.53 –0.530880 –0.529120

20 0.48 0.479345 0.480655

20 0 –0.000175 0.000175

20 –0.48 –0.480655 –0.479345

22 0.43 0.429395 0.430605

22 0 –0.000175 0.000175

22 –0.43 –0.430605 –0.429395

24 0.4 0.399425 0.400575

24 0 –0.000175 0.000175

24 –0.4 –0.400575 –0.399425

27 0.35 0.349475 0.350525

27 0 –0.000175 0.000175

27 –0.35 –0.350525 –0.349475

31 0.31 0.309515 0.310485

31 0 –0.000175 0.000175

Table 19.  NI PXI-4220 Gain and Offset Calibration Table (Continued)

Gain Test Point (V) Lower Limit (V) Upper Limit (V)
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31 –0.31 –0.310485 –0.309515

36 0.26 0.259565 0.260435

36 0 –0.000175 0.000175

36 –0.26 –0.260435 –0.259565

42 0.23 0.229685 0.230315

42 0 –0.000085 0.000085

42 –0.23 –0.230315 –0.229685

56 0.17 0.169745 0.170255

56 0 –0.000085 0.000085

56 –0.17 –0.170255 –0.169745

65 0.15 0.149765 0.150235

65 0 –0.000085 0.000085

65 –0.15 –0.150235 –0.149765

75 0.13 0.129785 0.130215

75 0 –0.000085 0.000085

75 –0.13 –0.130215 –0.129785

87 0.11 0.109805 0.110195

87 0 –0.000085 0.000085

87 –0.11 –0.110195 –0.109805

100 0.095 0.094850 0.095150

100 0 –0.000055 0.000055

100 –0.095 –0.095150 –0.094850

110 0.086 0.085859 0.086141

110 0 –0.000055 0.000055

110 –0.086 –0.086141 –0.085859

130 0.073 0.072872 0.073128

130 0 –0.000055 0.000055

Table 19.  NI PXI-4220 Gain and Offset Calibration Table (Continued)

Gain Test Point (V) Lower Limit (V) Upper Limit (V)
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130 –0.073 –0.073128 –0.072872

150 0.063 0.062882 0.063118

150 0 –0.000055 0.000055

150 –0.063 –0.063118 –0.062882

180 0.053 0.052892 0.053108

180 0 –0.000055 0.000055

180 –0.053 –0.053108 –0.052892

200 0.048 0.047900 0.048101

200 0 –0.000053 0.000053

200 –0.048 –0.048101 –0.047900

220 0.043 0.042905 0.043096

220 0 –0.000053 0.000053

220 –0.043 –0.043096 –0.042905

240 0.04 0.039908 0.040093

240 0 –0.000053 0.000053

240 –0.04 –0.040093 –0.039908

270 0.035 0.034913 0.035088

270 0 –0.000053 0.000053

270 –0.035 –0.035088 –0.034913

310 0.031 0.030917 0.031084

310 0 –0.000053 0.000053

310 –0.031 –0.031084 –0.030917

360 0.026 0.025922 0.026079

360 0 –0.000053 0.000053

360 –0.026 –0.026079 –0.025922

420 0.023 0.022926 0.023074

420 0 –0.000051 0.000051

Table 19.  NI PXI-4220 Gain and Offset Calibration Table (Continued)

Gain Test Point (V) Lower Limit (V) Upper Limit (V)



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. 
Refer to the Terms of Use section on ni.com/legal for more information about National 
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade 
names of their respective companies. For patents covering National Instruments products, refer to the 
appropriate location: Help»Patents in your software, the patents.txt file on your CD, or 
ni.com/patents.

© 2005 National Instruments Corporation. All rights reserved.  370634A-01 Nov05

420 –0.023 –0.023074 –0.022926

560 0.017 0.016932 0.017068

560 0 –0.000051 0.000051

560 –0.017 –0.017068 –0.016932

650 0.015 0.014934 0.015066

650 0 –0.000051 0.000051

650 –0.015 –0.015066 –0.014934

750 0.013 0.012936 0.013064

750 0 –0.000051 0.000051

750 –0.013 –0.013064 –0.012936

870 0.011 0.010938 0.011062

870 0 –0.000051 0.000051

870 –0.011 –0.011062 –0.010938

1000 0.0095 0.009440 0.009561

1000 0 –0.000051 0.000051

1000 –0.0095 –0.009561 –0.009440

Table 20.  Excitation Limits

Excitation (V) Lower Limit (V) Upper Limit (V)

0 – 0.020000 0.020000

2.5 2.472500 2.527500

5 4.965000 5.035000

7.5 7.457500 7.542500

10 9.950000 10.050000

Table 19.  NI PXI-4220 Gain and Offset Calibration Table (Continued)

Gain Test Point (V) Lower Limit (V) Upper Limit (V)
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